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President’s Post 
 

Spring is in the air!  Announcing a new column in Newsbrief called “RCBA 
Members’ Good News!”  As often as possible we will publish a piece (or two) 
of uplifting news about one (or more) of our Members!  Our new column ap-
pears in this month’s edition on Page 15.  We are thrilled to be able to announce 
the happy news of two of our Members, Daniella Pascaru and Joe D’Urso, 
whose “good news” is the birth of their daughter, Isabella.  Please send in your 
Good News and tidings items and photos to Barbara at  
Barbara@rocklandbar.org  
 
Speaking of Spring and rebirth, RCBA celebrates the rebirth of our New Law-
yers and Social Committee.  This Committee is planning its first social event, 
which will embrace both new and “old” lawyers, and those in-between.  The 
Committee wants to develop a cadre of experienced attorneys willing to mentor 
newly admitted attorneys.  Another Spring celebration is the on-going interest in 
the newly established Pro Bono Committee.  Since our announcement in last 
month’s Newsbrief we have heard from several Members who will lead this 
new Committee. To get involved, email our Executive Director, Nancy Low-
Hogan at Nancy@Rocklandbar.org.   
 
On a different note, we have to be aware of the pitfalls of legal research created 
by ChatGPT or any other platform of artificial intelligence.  There have been 
multiple attorneys facing discipline for fictional legal authority citations provid-
ed by generative artificial intelligence.  Recently, two New York lawyers were 
sanctioned by a District Court Judge for submitting a brief with multiple fake 
citations.  Another attorney admitted to the Second Circuit Court of Appeals 
that she relied on generative artificial intelligence in identifying precedents that 
might support her position but did not read or otherwise confirm the validity of 
what was cited.  She was referred to the grievance panel. 
 
A helpful admonition is if one uses artificial intelligence employ it as an adjunct 
to your own research or spring board for further inquiry.  Make sure that no au-
thority is cited without checking its applicability or lack thereof. 
 
Empathy. I recently came across an article highlighting empathy as an important 
leadership skill.  Leading with empathy has positive mental health benefits.  It 
promotes innovation and retention.  During the pandemic, one study indicated 
that over 40% of people experienced a decline in mental health and almost 70% 
of people encountered unhealthy and excessive stress with almost 60% having 
increased anxiety.  

 Continued... 

mailto:Barbara@rocklandbar.org
mailto:Nancy@Rocklandbar.org
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Continued… 

Why empathy?  It has been found to be a powerful palliative contributing experience for both individuals 
and teams.  When leaders are empathic, there is more innovation.  When leaders are empathetic, there is 
more engagement as well as retention of work force.  Think about how we can be more empathetic to those 
we work with.  Whether it’s a paralegal or an associate, empathizing with their circumstances, their stress 
levels, workloads, and being considerate of difficulties others may be experiencing will reap benefits.  We 
don’t have to be an expert in mental health in order to show that we care and are paying attention.  Just ask-
ing basic questions and taking clues from employees about what they want to share is important.  Keep the 
door to communication open.  Ask about an employee’s spouse, their children, athletic endeavors and 
what’s happening outside of work.  Genuinely care.  Empathy should not be something from left field.  It is 
a real-life way of interacting and demonstrating that you are a concerned leader.    
 
I am also musing about the importance of client communication as an integral necessity in the practice of 
law.  Many grievances arise from the failure to return telephone calls.  It is so very important to call clients 
back as soon as possible.  If you are engaged in another matter, then assign the task to a paralegal or some-
one in the firm.  Many complaints against lawyers emanate from the failure to communicate.  Technology 
allows one to communicate by email or text messaging.  We have to consider when too much time has 
elapsed.  Merely calling a client and inquiring as to how they are doing or how you can help is particularly 
important.  Client communication requires one makes sure that confidentiality is maintained especially when 
texting or emailing.  A text message is probably the most efficient and rapid way of communicating.  When 
you email, attempt to address the email to one’s personal account rather than to a work issued email.  If you 
decide to telephone and leave a voicemail, make sure it’s on the client’s personal line and not amenable to 
access by others.  In the personal injury field, it is important to maintain ongoing contact to find out how the 
client’s medical condition and treatment is progressing.  I believe that our clients are appreciative when they 
get an unsolicited call inquiring about their current symptoms and complaints, especially during the week-
end. 
 
What I am conveying is the importance of an ongoing dialogue and meaningful interaction with our clients.  
If we produce a collaborative lawyer-client relationship the concomitant benefit obviously reduces the likeli-
hood of a grievance.  
 
I am very pleased to let you know that our Nominating Committee has completed their interviews for the 
2024-25 RCBA Board of Directors.  The names of those nominated will be announced this month and the 
Membership will vote in an election to be held this April. 
 
 

May the wind be always at your back.   
May the sun shine warm upon your face. 

 
Happy St. Patrick’s Day to all. 
 
 
Sincerely, 

Robert (Rob) L. Fellows, Esq.— President 
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NOTICE OF NOMINATIONS  

FOR THE 2024/25 BOARD OF DIRECTORS  

FOR THE ROCKLAND COUNTY BAR ASSOCIATION 

 

Pursuant to Article V, Section 9 of the By Laws of the Rockland 

County Bar Association, the Nominating Committee has nominated 

the following candidates for election to the Association’s            

Board of Directors:  

 

Jeffrey M. Adams (3-year term) 

Judith Bachman (3-year term) 

Alicia B. Cember( 3-year term) 

George G. Coffinas (1-year term) 

Robert L. Fellows (3-year term) 

Jay Golland (3-year term) 

Helena Phillibert (3-year term) 

 

 

Any member of the Association not selected by the Nominating Committee who 

wishes to have his or her name placed in nomination for election to the Board, 

whether or not he or she solicited nomination from the Nominating Committee, 

shall submit a petition to place his or her name before the membership.  The peti-

tion must be signed by no fewer than twenty (20) members in good standing with 

the Association and must be submitted in person at the offices of the Bar Associ-

ation, 337 N. Main Street, Suite 1, New City, NY, 10956, no later than April  5, 

2024.  
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NOMINATIONS FOR AWARDS 

We have a membership of many outstanding attorneys. Each year we recognize those that are         

nominated by their peers. If you would like to nominate someone for one or more of our awards, 

please fill out this form and fax (845-634-1055) or e-mail nancy@rocklandbar.org. Final decisions are 

made by our Board of Directors at an upcoming Board Meeting. Please submit your nominations as 

soon as possible. 

THE LIBERTY BELL AWARD This award is presented on Law Day to a member of our Community for 

outstanding service in promoting a better understanding or respect for the Constitution, the Bill of Rights 

and our institutions of government. Generally this award is usually given to a non-lawyer. 
  

I wish to Nominate: 

_______________________________________________________________________________________ 
  

THE STERNS AWARD Given in the memory of Richard Sterns to a RCBA member who has made signifi

-cant contributions to the Bar Association and the People of Rockland County over the year - service above 

self on behalf of the association. This award is presented at the Installation Dinner in June. 
  

I wish to Nominate: 

_______________________________________________________________________________________ 
  

THE LIFETIME ACHIEVEMENT AWARD Presented to an individual for exemplary achievements as 

an attorney or judge over a career. This award is presented at the Annual Dinner. 
  

I wish to Nominate: 

_______________________________________________________________________________________ 
  

THE JOSEPH G. BALSAMO AWARD This award is presented at the June Installation Dinner in 

memory of Joseph G. Balsamo, Esq., to a RCBA member who has gained significant respect from the mem-

bers of the Bar and the public for his or her personal and professional contributions to both, while maintain-

ing the highest form of integrity and professionalism while advocating for each. 
  

I wish to Nominate: 

_______________________________________________________________________________________ 
  

THE NATALIE COUCH AWARD This award is dedicated to the memory of Natalie Couch, a pioneering 

member and president of the Rockland County Bar Association, who was a voting rights advocate and an in-

fluential community leader. The honoree should be someone whose own accomplishments have served to 

inspire others to overcome prejudice and barriers in attaining their goals for the benefit of our community. 

This award is presented at the Annual Dinner. 
  

I wish to Nominate: 

_______________________________________________________________________________________ 
  

Please print this page, complete Form & FAX to 845-634-1055, or scan and send to Nancy@rocklandbar.org 

mailto:nancy@rocklandbar.org
mailto:office@rocklandbar.org
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 OUR PROFESSIONAL ETHICS 

Richard A. Glickel, Esq.* 

 

 Fans of classic cinema must remember actor Raymond Massey, (“Abe Lincoln in Illinois,” “Arsenic & 
Old Lace” and “East of Eden,” are some of his more memorable motion pictures over a career spanning five dec-
ades). In mid-career, the actor’s personal life rendered an unusual, if not unique, post-divorce sidebar forever en-
sconced in New York legal lore, when, during 1939, Raymond Massey and his actress-wife, Adrianne Allen end-
ed their 10-year marriage. Massey and Allen were each represented by husband-and-wife attorneys William and 
Dorothy Whitney. When the divorce proceedings concluded, the lawyers divorced and married their respective 
actor clients! Those subsequent nuptials lasted a lifetime for both pairs. The real-life divorce proceeding pitting 
lawyer-spouses in opposing corners, inspired the screenplay authored by husband and wife, Ruth Gordon & Gar-
son Kanin (who, incidentally, were friends with the Masseys and the Whitneys) for the 1949 Hollywood Battle of 
the Sexes, “Adam’s Rib,” starring (for the sixth time in their storied careers), Spencer Tracy and Katherine Hep-
burn, (who were, also, famously romantically entwined), as husband and wife lawyers on opposite sides of a sen-
sational homicide prosecution (he for the State, she for the defense). 

 

  

                          A Romantic Relationship Presents a Personal Interest Conflict.  

 

 1940’s screenwriters wouldn’t know of, nor have concern for, New York’s yet-to-be promulgated Rules 
of Professional Conduct (“Rules”) and prohibited lawyer conflicts of interest. And, while “the heart wants what 
the heart wants,” a criminal defense lawyer’s romantic relationship with opposing counsel may still result in the 
attorneys’ disqualification as well as the imputed disqualification of the attorneys’ office(s).  

 

 Rule 1.7 (a)(2) provides that a lawyer may not represent a client if a reasonable lawyer would conclude 
that “there is a significant risk that the lawyer’s professional judgment on behalf of a client will be adversely af-
fected by the lawyer’s own . . . personal interests” unless the conflict is consentable under Rule 1.7(b) and the 
conflicted lawyer obtains the client’s informed consent, confirmed in writing. 

 

 Comment [11] to Rule 1.7, addresses instances where related lawyers are involved on opposite sides of a 
case: 

[11] When lawyers representing different clients in the same matter or in substantially related  

matters are closely related, there may be a significant risk that client confidences will be  

revealed and that the lawyer’s family relationship will interfere with both loyalty and  

professional judgment. As a result, each client is entitled to know of the existence and  

implications of the relationship between the lawyers, before the lawyer agrees to  

undertake the representation. Thus, a lawyer who has a significant intimate or close family 

 relationship with another lawyer ordinarily may not represent a client in a matter where  

that other lawyer is representing another party, unless each client gives informed consent,  

as defined in Rule 1.0(j).   

   

Continued... 
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Under Rule 1.7(b), a conflict is sometimes unconsentable. “Consentability is typically determined by considering 
whether the interests of the clients will be adequately protected if the clients consent to representation burdened 
by a conflict of interest” (Comment [15]); and, determining whether a conflict is nonconsentable will depend on 
the facts and circumstances. But a romantic relationship between a prosecutor and the defense attorney would be 
a noncontestable conflict. 

 

 In N.Y. State 660 (1994), NYSBA’s Committee on Professional Ethics reviewed the close personal rela-
tionship between a criminal defense associate and an assistant district attorney in the county in which the associ-
ate’s firm was located. The Committee concluded that “[u]nder the circumstances, it would not be unreasonable 
to assume that they each had a personal interest in one another’s reputation, success and welfare” that “ordinarily 
would operate to disqualify the lawyers from undertaking an adverse representation without the consent of their 
respective clients.”  

 

 Noting that a “scintilla of partiality, which might be waivable by private parties in other contexts, is intol-
erably suspect and prejudicial to the public’s regard for the criminal justice system,” the Committee stated: 

Irrespective of the subjective intent of the prosecutor and defense counsel, and regardless of howsoever 
scrupulous they may be in the conduct of their professional obligations, the appearance of partiality in the 
administration of justice is so strong that a couple who date frequently should not be permitted to appear 
opposite one another in criminal cases.           

N.Y. State 660. 

 

 If the personal conflict is nonconsentable under Rule 1.7(b), and there are no exceptions to disqualifica-
tion, there is imputed disqualification to the lawyer’s entire firm under Rule 1.10(a). We note that New York’s 
Rules differ from the ABA’s Model Rules on whether personal interest conflicts are imputed within an entire law 
firm, which specifically provide that personal conflicts of interest of one lawyer in a firm are not imputed to other 
lawyers in the firm unless the conflict presents a significant risk of materially limiting representation by the other 
lawyers in the firm.  

 

It was, no doubt, in consideration of the Model Rule’s different language that the Committee recently par-
tially modified N.Y. State 660, to the extent that it concludes whether other lawyers in a firm will be automatical-
ly disqualified as follows: “If the lawyer is disqualified in circumstances where the conflict is nonconsentable, 
the disqualification is imputed to the lawyer’s firm, but the imputed conflict may be waived with client consent 
even if the conflict is nonconsentable as to that lawyer, so as to allow other lawyers in the firm to accept or con-
tinue the representation.” So, “if another lawyer in the disqualified lawyer’s firm reasonably believes he or she 
will be able to provide competent and diligent representation to the client and the client gives informed consent, 
confirmed in writing, then that other lawyer may undertake the representation. In other words, the client may 
waive the conflict imputed to other lawyers in the disqualified lawyer’s firm even if the lawyer’s own conflict 
would be unconsentable.” N.Y. State 1255.  

 

 I love old movies.      

 

*Chair, RCBA Committee on Professional Ethics  

 

RCBA members may request an informal opinion on issues of ethical concern from the Association’s Committee on Profes-
sional Ethics by addressing their written question(s) to:  rglickel@glickelaw.com  

 

mailto:rglickel@glickelaw.com
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THE PRACTICE PAGE  

  THE NYS “LEMON LAW”… NOT APPLICABLE TO LEMONADE    

 

Hon. Mark C. Dillon * 

 

 Let’s talk cars, whether owned or leased.  And motorcycles.  And while we’re at it, motor homes. 

 The New York “Lemon Law” (GBL 198-a) provides special consumer protections if a vehicle is cov-

ered by an express manufacturer’s warranty at the time of its original delivery.  It applies to vehicles registered 

in New York for a period of two years from the original delivery or for 18,000 miles, whichever occurs first.  

The law requires that the manufacturer, agent, or dealer perform warranty repairs for the consumer for no 

charge, so long as the vehicle is within the statutory two-year/18,000 mile window.  While that portion of the 

law merely enforces many repairs that should be made under warranty anyway, the statute has an important 

kicker: the manufacturer has a duty to replace or repurchase the vehicle if the warranty repair cannot be made 

after four or more attempts or if the vehicle is out of service thirty or more calendar days as a cumulative result 

of one or more repair attempts.  In the event that a consumer chooses to receive a replacement vehicle rather 

than its repurchase price, the vehicle provided is to be comparable --- meaning the same year, model, and ap-

proximate odometer mileage. 

 A key to the remedies of the Lemon Law is that there be a non-conforming defect with the vehicle 

which cannot be repaired despite the reasonable attempts required by the statute.  That requirement was central 

in the case of Matter of BMW of North America, LLC v Dean, 215 A.D.3d 746 (2023), which warrants some 

discussion.  The respondent, Avery Dean (Dean), custom ordered a 2019 BMW X3 with standard features and 

other carefully-selected upgrades, which rendered that BMW an expensive but desirable quality vehicle.  One 

of the vehicle’s features was a “Comfort Access System.”  A Comfort Access System automatically unlocks 

the doors and starts the engine when the owner merely walks within a certain proximity of the vehicle.  The 

owner need not use a key or even press any button on a fob.  The vehicle transmits a constant signal seeking 

the owner’s fob, and when the fob comes within sensor range, the owner can enter the vehicle and drive away 

without the inconvenience of unlocking any door or turning the ignition.  In Dean’s case, the system some-

times worked.  But there were other occasions when the owner would walk toward the vehicle intending to 

drive it, and contrary to the promise of the Comfort Access System, was forced to use his fob to push a button 

to unlock the car door and to then manually activate the engine.   

 

Continued... 
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… Continued 

 

 Dean brought his BMW to the petitioner, BMW of North America, Inc. (Dealer), on five occasions for 

warranty repairs to address the issue.  The Dealer failed to correct the problem.  As a result, Dean requested an 

arbitration required by the Lemon Law seeking a refund of the vehicle’s value.  Ultimately, the arbitrator’s de-

termination became the subject of a CPLR 7511 proceeding and its appellate review.  Here, Dean failed to es-

tablish that there was any actual defect in the materials or workmanship covered by the vehicle’s express war-

ranty.  Rather, the Comfort Access System was specifically designed to enter a sleep mode if not operated for 

approximately two days, so that its constant search signal would not drain and kill the car’s battery which pow-

ered it.  Once the Comfort Access System entered its sleep mode, it could not operate when the owner’s fob 

came within range without the vehicle first being manually started to re-activate the search feature.  Thus, 

while the owner’s enjoyment of the automatic unlock and ignition feature was spotty, there was no “defect” in 

the design or manufacture of the car which was instead performing as specifically designed and intended.  The 

Appellate Division further found that the shortcomings of the Comfort Access System did not affect vehicular 

safety, nor did it substantially impair the value of the vehicle.  

 The bottom line for the Lemon Law is that there must actually be a bitter lemon to trigger the statutory 

remedies, and not lemonade intentionally sweetened with sugar.  

 

*Mark C. Dillon is a Justice of the Appellate Division, 2nd Dep’t., an Adjunct Professor of New York Practice 

at Fordham Law School, and a contributing author of CPLR Practice Commentaries in McKinney’s.   
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COMMERCIAL LITIGATION ISSUES OF INTEREST   

  Submitted by Joseph Churgin, Esq. and Susan Cooper, Esq.* 

 

 

Your client contracted to purchase three properties from the same seller and made downpayments totaling 

$600,000, to be held in escrow. Each of the three contracts provided that your client’s “sole and exclusive rem-

edy” for seller’s failure to convey the properties was to either terminate the agreement and recover the deposit, 

or seek specific performance. The seller set a time of the essence closing date but failed to obtain assignments 

of mortgages on the properties, as required by the contracts. Your client terminated the contracts, but the seller 

did not return the deposits. You sued for return of the downpayment plus pre-judgment interest. The court 

granted your client judgment for the return of the downpayment but denied pre-judgment interest, holding that 

the “sole and exclusive” remedy provision constituted a waiver of pre-judgment interest otherwise authorized 

by CPLR 5001(a). You appealed. 

 Will you prevail on appeal and be awarded pre-judgment interest? 

 The answer is yes.  

 In IHG Harlem I LLC v. 406 Manhattan LLC, 2024 WL 157301 (1st Dep’t, January 16, 2024) (NYLJ 

1705500098NY16186315, Case No.161863/15), the plaintiff sued the defendant for breach of three contracts 

to purchase real property, seeking return of the escrowed downpayment of $626,250 plus pre-judgment inter-

est. The contracts each provided for the plaintiff to choose, “as its sole and exclusive remedy,” either termina-

tion of the contracts and the return of its deposits, or specific performance. On a prior appeal decided in 2021 

(200 A.D.3d 417, 418), the First Department held 1) that the defendant breached the contract by failing to ob-

tain the contractually required assignment of mortgages on the properties; and 2) “As the plaintiff has elected 

not to seek specific performance, its sole remedy is the return of its deposits.”  

 After the first appeal, the plaintiff presented a proposed judgment to Supreme Court for signature for 

the amount held in escrow plus statutory pre-judgment interest. The Supreme Court signed defendants’ counter

-proposed judgment, which directed return of the escrowed funds without interest. The Supreme Court   

Continued... 
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… Continued 

 

reasoned that J. D’Addario and Sommer v. General Bronze Corp. (28 A.D.2d 981 [1st Dept 1967], aff’d 21 

N.Y.2d 775 [1968]) constituted precedent requiring denial of interest. In that case, the seller was denied an  

award of statutory interest on the deposit it had returned to the purchaser, because the contract provided the seller 

would have no further rights once the downpayment was paid as liquidated damages. The Supreme Court also ex-

plained that denying interest was consistent with the Appellate Division’s decision on the earlier appeal, which 

did not award a judgment with interest. 

On plaintiff’s appeal from the judgment, the Court stated, “The sole remaining issue, and the subject of this ap-

peal, is whether plaintiff is entitled to statutory interest on the return of its deposit, or, by the language in the con-

tracts, it waived its right to collect prejudgment interest.” The Court noted that CPLR 5001(a) provides that inter-

est “shall” be awarded for breach of contract, and explained that awarding statutory interest on escrowed amounts 

“is not to punish the breaching party, but rather to compensate the wronged party for the loss of use of their mon-

ey,” citing numerous cases. It noted that that the statutory right to interest can be waived only by a clearly mani-

fested intent to do so, as required for waivers in other contexts, citing Navillus Tile v. Turner Const. Co., 2 A.D.3d 

209, 211 (1st Dep’t 2003). 

The Court agreed with plaintiff that Supreme Court employed too broad a reading of D’Addario, where, in 

addition to the contract using the terms “sole remedy,” “sole obligation,” and “no further rights,” the contract also 

provided that the escrowed funds were required to be placed in an interest-bearing account. Compensation for 

deprivation of the use of the money was provided in the form of bank-accrued interest, clearly establishing that 

the parties did not contemplate interest paid at the statutory rate.  

By contrast, the contracts under review here made no such provision for the plaintiff’s lost use of its mon-

ey. Although the contract did provide for the funds to be held in an IOLA account, the interest accrued in that type 

of account is paid to the state IOLA fund, not to the prevailing party. There was no provision for compensation to 

the plaintiff for lost use of the funds.  

  

Continued...  
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… Continued 

 

As to the prior appeal, the Court ruled that the direction to return the deposits to plaintiff as liquidated 

damages does not preclude statutory prejudgment interest. 

The Court held that interest should be computed at the statutory rate of 9% from the date of the breach 

(the time of the essence closing date fixed by the seller) through the date the downpayment was finally returned 

seven years later. 

The lesson? To protect your client against having to pay anything more than the amount provided in a 

liquidated damages clause, there should be an express waiver of all other damages, including loss of use of de-

posited funds. If you represent a seller, be sure to provide for purchaser’s deposits to be placed in an interest-

bearing account that is not an IOLA account. Otherwise, statutory prejudgment interest of 9% could be added 

to a judgement for breach of contract.   

*By Joseph Churgin, Esq. and Susan Cooper, Esq. of 

SAVAD CHURGIN, LLP, Attorneys at Law 
 

Promoting equal access to justice and greater understanding of the law.                                                 Page 

The Rockland County Bar Association has a Facebook page where we announce upcoming 
events and other issues of interest to the local community.  

Visit and follow the page and “Like” the postings to help your association be seen! 

https://www.facebook.com/profile.php?id=100064010614856
https://www.facebook.com/profile.php?id=100064010614856
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Thank you for talking with me today!  We are looking forward to learning 

a little bit about you in today’s Spotlight Interview.  Why don’t we start 

with telling us where you grew up?   I grew up in the Bronx.  I then moved 

slightly north to Yonkers until 2001 when I moved to Garnerville, here in Rock-

land County.    

Did you always want to be a Lawyer?  Actually, no.  I wanted to be a doctor.  

After graduating from Lehman High School in the Bronx, I went to NYU and 

majored in pre-med.  Shortly thereafter, I realized that medicine wasn’t my call-

ing and I left NYU.  I started working for a real estate company as a receptionist.   

At that time, I was a single mother of two young girls, ages four and five years 

old.  I really enjoyed the real estate industry, and I soon obtained my salesperson 

license. After a few years I realized that I wanted to strive for something more 

and build a career for myself and my family.   

Did you consider going back to school at that time?  Yes. I attended Iona col-

lege in New Rochelle.   Even though I worked in the real estate industry I ma-

jored in Criminal Justice.  The Criminal Justice field always interested me, and I 

knew that there was a possibility I could make a career in this area.  After gradu-

ation, I was accepted into Pace University School of Law.  I attended the day-program and worked as a Mort-

gage Loan Officer at night.   While working as a Mortgage Loan Officer, I made many connections in the 

Real Estate industry and after graduation, I decided to build a career in real estate law.  I started out my prac-

tice renting a desk from a mortgage loan officer and now I have my own thriving real estate law firm.  I have 

always been a solo practitioner and I am very proud of that.   

Tell us more about your career?  I have been practicing law since 2000. I started out in the East Tremont 
section of the Bronx where I practiced Real Estate Law.  A few years after moving to Rockland County I 
opened a second office here in Rockland County.  My Real Estate law practice continued to thrive and in 
2008 I had the honor of becoming a Special Prosecutor for the Town of Haverstraw. In 2010, I was asked to 

be a Special Prosecutor for the Village of West Haverstraw as well. I served in both positions until 2017, 
when I was appointed as Town Justice to the Town of Haverstraw and then elected to this position the fol-
lowing year.  

 

Continued... 
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The Committee on Diversity,  

Equity & Inclusion presents… 

SPOTLIGHT  
In Honor of Women’s History Month, the Diversity, Equity, and      

Inclusion Committee had the pleasure of interviewing                     

Hon. Ivonne Santos, Judge of the Town of Haverstraw.  
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Continued... 
 
It looks like your criminal justice major from college came full circle!  Yes, absolutely. I am so grateful 

to be in this position and to have had the support from so many people in our community and in our Town.  I 

am always open and willing to learn, and I am grateful every day I am in this position.  I also feel a great 

sense of pride in knowing that the people that come into my courtroom see someone that looks like them.  It 

is their community looking back at them.  I am so very proud of that.  I am also so proud to be the first wom-

an to sit as a Judge in the Town of Haverstraw.   

 

Thank you for sharing your professional life with us, can you tell us a little bit about your personal 

life?  Of course!  I am a mom to three amazing daughters:  Ashley, Amy, and Felicia.  Ashley is a Nurse 

Manager in Labor and Delivery at New York Presbyterian Hospital.  Amy is a Bilingual Secondary math 

teacher and Felicia is in her third year at St. Thomas Aquinas College, here in Rockland.  I am also a grand-

mother of five grandchildren, with one on the way!   

 

Who is your inspiration or Hero?  My mother.  My mom was a single mother and she worked very hard to 

provide for our family.  We always had suitable housing, neat clothes for school and we never went without.  

As a child, I never realized all those sacrifices, but as a mother, I understand now.  I, too, made those sacri-

fices and will always make those sacrifices for my family.  I learned this from my mom.  She was strict and 

had high expectations of me and I never wanted to let her down because I knew how hard she worked for me.  

The way she raised me made me the person and mother I am today. 

 

What is one piece of good advice that you have received or learned?   The phrase “You got this”.  You 
must believe that you have it within you, you just must learn how to get it out of yourself!   You must always 

believe in yourself and your abilities.  You must always tell yourself “You got this!”     

Tell us one of your guilty pleasures.  Chocolate!  I love chocolate!! 

 

Is there anything else we didn’t cover that you would like the Bar Association to know about you?  Be-
ing involved in the community that I live in is very important to me. I regularly attend events and help coor-
dinate Community outreach for the holidays in the Village of Haverstraw. For the past several years, I have 

worked alongside other community members and organized events for Christmas and Thanksgiving.  These 
events provide food and toys to families.  These opportunities have allowed me to give back to the wonderful 
community I work and live in. I am also involved with Girl Scouts.  While my daughters are no longer in this 

phase of their lives, I continue to be passionate about advocating for future generations of girls to know their 
worth, as well as educating them about how to present themselves in this world.  It is important to instill val-
ues and knowledge in our youth.  Girl Scouts affords me the opportunity to teach young women that they 

matter and the importance of placing value on themselves.  Girl Scouts is a wonderful organization and I re-
ally enjoy being a part of it and helping shape the lives of young girls in my community. 
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RCBA MEMBERS’ 2023 

HISTORIC 130
TH

 ANNIVERSARY 

COMPOSITE GROUP PHOTO 

COMPOSITE PHOTO IS NOW AVAILABLE FOR SALE!  

To purchase the 130
th

 Anniversary Historic Composite: 

Go to: https://igorlacertisphotography.shootproof.com/gallery/23962558 

Click on “Gallery” in the lower right hand corner 

Password is “RCBA” 

When the page opens click on “View Gallery” 

Then click on the small photo in the lower left hand corner 

Click on “Buy Photo” in the top right of the page  

Price List 

 Composite: 

16”X20”- $85 

24”X30” - $175 

30”X40” - $250 

Prints of Headshots: 

High Resolution Digital File of Individual Photo - $30 

Retouching (per file) - $20 

5”X7” Print - $25 

8”X10” Print—$35 

 
To purchase prints of your own photo: 

  Go to:  www.lacertisphoto.com 

• Click on CLIENT LOG IN 

• Click on CONTINUE TO GALLERY PAGE 

• Click on Rockland County Bar Association 

• Click on VIEW GALLERY 

• Enter your email address and the Gallery Password which is RCBA 

• Select Your Day (the day you had your photos taken) 

• See your name in alphabetical order by last name and click on it 

• Enter your password which is your last name 

       View your photos and enjoy! 

 

Promoting equal access to justice and greater understanding of the law.                                                  Page 

https://igorlacertisphotography.shootproof.com/gallery/23962558
http://www.lacertisphoto.com


 17 

 

 

Technology T ips for  Attorneys  

submitted by 

Michael Loewenberg* 

 

For the past few months, we’ve been exploring how to use technology effectively in your practice. This 

month let’s review some lesser-known features of the staple tool, Microsoft Word. Its full potential often 

remains untapped beyond the basics.  These features within Word can significantly streamline legal work 

and enhance productivity.  

 

Open Word on your computer and let's dive into some of these hidden gems: 

 

1. Document Navigation Pane: 

Navigating lengthy legal documents can be cumbersome, especially when searching for specific sections 

or references. The Document Navigation Pane in Word acts as a roadmap, allowing you to easily move 

between headings, pages, and sections with a simple click. By activating this feature through the View 

tab, you can efficiently traverse complex documents, saving valuable time during review and editing. 

 

2. Document Comparison: 

Legal professionals frequently deal with document revisions and versions, often requiring meticulous 

comparison between drafts. Word's built-in document comparison tool simplifies this process by high-

lighting differences between two documents side by side. Accessed through the Review tab under Com-

pare, this feature enables you to identify changes, track edits, and ensure document accuracy with ease. 

 

3. Table of Authorities: 

Crafting comprehensive legal briefs often involves citing numerous cases, statutes, and regulations. 

Word's Table of Authorities feature automates the tedious task of creating and updating citation indexes. 

By marking citations using the References tab, you can generate a dynamic table of authorities with a few 

simple clicks, facilitating accurate referencing and enhancing document organization. 

 

Continued... 
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...Continued 

 

4. Quick Parts: 

Legal documents frequently contain repetitive content such as boilerplate clauses, signature blocks, and 

disclaimers. Word's Quick Parts feature (it’s in the Insert tab) allows you to save and insert frequently 

used text snippets quickly and easily. By selecting and saving content to the Quick Parts Gallery, attor-

neys can expedite document assembly, minimize errors, and maintain consistency across their work. 

 

5. Document Protection: 

Confidentiality and data security are paramount in legal practice. Word's document protection features 

offer robust safeguards to prevent unauthorized access and modifications. You can restrict editing, en-

force password protection, and apply digital signatures to safeguard sensitive information, ensuring client 

confidentiality and regulatory compliance.  You can find the settings under File > Info. 

 

6. Document Metadata Removal: 

Protecting client privacy extends beyond document content to include hidden metadata such as author de-

tails, revision history, and document properties. Word's metadata removal tool enables you to scrub sensi-

tive information from documents before sharing or distributing them externally. By accessing the Inspect 

Document feature under File > Info > Inspect Document, you can review and remove potentially compro-

mising metadata, safeguarding client confidentiality and mitigating privacy risks. 

 

Microsoft Word offers a treasure trove of features beyond its basic word processing capabilities, provid-

ing powerful tools to streamline legal workflows, enhance document precision, and safeguard client confi-

dentiality.  

 
*Michael Loewenberg is the President of MESH Business Solutions, Inc., New City, NY, 10956 and he is 
also an Affiliate Member of the RCBA. 
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SUCCESSION  

A new Newsbrief column 

By Judith Bachman, ESQ. 

 

Moving Laterally to the Next Exit? 

 

In our continuing discussion of the topic of succession and how to exit your law practice, one possibility is to 
make a lateral move to a larger firm.  As the owner and managing partner of my small law firm, I have been 
approached numerous times by both headhunters and larger firms (ranging from 10 person shops to Am Law 
100 firms) about moving laterally to another firm.   

 

There are several enticements for moving laterally.  Being part of a larger firm would offer a former firm own-
er access to more associate attorneys.  A bigger firm, obviously, has significant advantages in its ability to re-
cruit, train, retain, and manage staff.  Also, a larger firm would provide marketing resources and brand identity 
that would enable a lateral to expand their reach.  

 

Even with those advantages, though, there are reasons to hesitate.    

First, clients may not follow their lawyer to a larger firm.  “[C]lients are completely free to choose which firm 
will best serve them.”  Gibbs v. Breed, Abbott Morgan, 271 A.D.2d 180, 710 N.Y.S.2d 578 (1st Dep’t 2000) 
citing Graubard Mollen v. Moskovitz, 86 N.Y.2d 112, 653 N.E.2d 1179, 629 N.Y.S.2d 1009 (1995). “As a mat-
ter of ethics, departing partners have been permitted to inform firm clients with whom they have a prior profes-
sional relationship about their impending withdrawal and new practice, and to remind the client of its freedom 
to retain counsel of its choice.”  New York City Bar Association, Formal Opinion 2023-1, Ethical Obligations 
of Lawyer and Law Firm Relating to Attorney Departures (June 30, 2023).  That means that, when making a 
lateral move, lawyers are required to notify their clients of the right to go with the moving lawyer or not.  Since 
clients have this freedom, moving to another firm raises the risk of losing clients, as for instance, the new firm 
may have higher billing rates, be geographically inconvenient, etc.  
 
This risk of client loss looms large when viewing the likely compensation arrangement for a lateral move. 
Compensation for someone moving laterally ultimately could be an ‘eat what you kill’ formula, e.g., the lateral 
gets 20% collections for work that they bring in, 35% of collections for the work that they do for other clients 
of the firm, and 55% of collections of the work that they bring in and perform.  This compensation formula 
could mean that a lateral is doing the same amount of work for less money and still bears the risk of collection 
as they do as a law firm owner.  By some calculations, a lateral would have to grow their book of business by 
about 30% as a lateral partner just to get the same amount of pay that they have as a law firm owner. 

So why would someone that owns their own firm make a lateral move?  This move makes sense for lawyers 
that no longer want the headaches of running their own firm.  They are willing to, essentially, pay the firm they 
are moving to, to handle all of the ownership chores, e.g., HR, marketing, IT, etc.  For someone who wants to 
eventually exit their firm, a lateral move might be a good interim step as part of a succession plan. 

_____________________________________________________________________________________ 

Judith Bachman, Esq. is the owner of The Bachman Law Firm in New City, NY 
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Join RCBA’s Lawyer Referral Service 

We receive several calls each day from clients looking for local representation. 
We welcome all members to participate but are especially in need of attorneys 

in these practice areas: 

Civil Appeals 

Commercial law 

Consumer law, including small claims court 

Constitutional and Human Rights 

Corporate Law including business formation, dissolution & franchises 

Education law 

Elder law 

Environmental Law 

Insurance Law, including automobile, home, disability, long term care 

Intellectual Property 

Landlord Tenant Law, including residential and commercial 

Legal Malpractice 

Zoning Law 

Visit our webpage or contact office@rocklandbar.org for more information and 

an application. 

THE ROCKLAND COUNTY BAR ASSOCIATION  

WELCOMES THE FOLLOWING NEW MEMBERS  

WHO HAVE JOINED SINCE FEBRUARY 2024 

Andrew Michael Finkiel, Esq. 

William Joseph Gallagher, Esq. 

Barbara Gionta, Esq. 

Mark Housman, Esq. 

Joshua Nathanson, Esq. 

We look forward to seeing you at 

our many CLE Programs and oth- er 

activities 

 

https://www.rocklandbar.org/member-resources/join-the-lawyer-referral-service/
mailto:office@rocklandbar.org
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REQUEST FOR PUBLIC COMMENT 

The Administrative Board of the Courts is seeking public comment on proposed amendments to Parts 623 

and 680, and the addition of new Parts 825 and 1024, of the Rules of the Appellate Division, relating to 

mental health professionals panel.  

This request will be posted on the OCA website at https://ww2.nycourts.gov/rules/comments/index.shtml 
in the next few days, and comments are due no later than Friday, April 4, 2024. 

https://ww2.nycourts.gov/rules/comments/index.shtml
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RCBA IS LOOKING FOR ADVERTISERS AND SPONSORS 

 

Dear RCBA Member, 

Who are your favorite vendors?  

Do you work with a process server, private investigator, translator, title company or court report-

ing company?  

The RCBA offers these businesses several ways to promote themselves to local attorneys. They 

can become Affiliate members, advertise on our website or in the Newsbrief, or sponsor one or 

more CLE programs or special events.  

If you have a favorite business, please let us know.  

Contact Barbara at Barbara@rocklandbar.org with their contact information so we can reach out 

to them about these opportunities.  

 

NEW INCENTIVE FOR YOU!  As an added incentive, when a business 

you referred becomes a Sponsor or places an ad with us, you will be given 

one free online CLE session. So… review your contacts now and help us 

promote their business! 

Contact:  Barbara Silverstone 

Barbara@rocklandbar.org 

845-634-2149 
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We thank our RCBA Supporters. 

For information on advertising 

in the Newsbrief, see page 27 

mailto:Barbara@rocklandbar.org
mailto:Barbara@rocklandbar.org
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NEWSBRIEF ADVERTISING RATES  

 

NEWSBRIEF ADVERTISING RATES  

Discounts: 10% for 6 mo. bookings, 20% for 1 year bookings. Must be paid for in advance 

 

  AD SIZE    REGULAR RATE    

  FULL PAGE (7.5x10.25)                            $400.00      

  1/2 PAGE (7.5x5):                                        $250.00      

  1/4 PAGE (3.75x5):                                      $200.00      

  1/8 PAGE (3.75x2.5):                                   $125.00     

  BUSINESS CARD:                                       $75.00      

 

CLASSIFIED ADS 

RCBA Members – free, up to 50 words; 51 to 100 words, cost is $75.00.   

Non-Members, cost is $50 for up to 50 words; 51 to 100 words, cost is $100. 

PLEASE NOTE:  

NEWSBRIEF IS NOT PUBLISHED IN JULY 

CALL BARBARA @ 845-634-2149 or send email to Barbara@Rocklandbar.org 

TO ADVERTISE IN NEWSBRIEF 

 

Advertising & articles appearing in the RCBA Newsletter does not presume endorsement 

of products, services & views of the Rockland County Bar  

Association. 

All advertisements and articles must be reviewed by the Executive Committee for content. 
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CLE CORNER  

   SAVE THE DATE FOR THESE CLE PROGRAMS! 

Promoting equal access to justice and greater understanding of the law.                                                 Page 

March 13, 2024. 6:00 p.m. —9:00 p.m. Foreclosure Update 2024  

Speakers will be  Judge Mark Dillon, Suzanne Berger, Esq., David Marcus, Esq. Derek 

Tarson, Esq. This program will be presented on Zoom. Register here. 

March 19, 2024. 1:00 p.m.—2:00 p.m. Jury Selection with the Commis-

sioner of Jurors. Speakers are Sabrina Greco, Commissioner of Jurors, and local 

civil and criminal attorneys. This program will be presented on Zoom. Register here. 

April 18, 2024. 12:30 p.m.—1:30 p.m. A Primer on Estate Practice   Speakers 

will be Courtney Boniface, Esq. and Amanda Henderson, Esq.  This program will be 

presented on Zoom.  

April 26, 2024. What to do when Divorce Leads to Bankruptcy (Can I Still 

Collect My Attorneys’ Fees?) Speakers will be Elizabeth Haas, Esq. and Dawn Kir-

by, Esq. This program will be presented on Zoom. 

May 10, 2024. 9:30 p.m.—12:30 p.m. CPLR Update 2024. Mark your calendar 

for the popular annual program. The speaker will be Professor Patrick Connors. This 

program will be presented on Zoom.  

May 21, 2024. The Life of a Workers’  Compensation Claim, presented by Va-

lerie Crown, Esq. This program will be presented on Zoom. 

Watch your emails for additional information and registration. 

Remember, RCBA Members receive a discounted registration fee for all CLE programs  

https://www.rocklandbar.org/calendar/signup/MjUx
https://www.rocklandbar.org/calendar/signup/MjU0
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 CLE REQUIREMENTS 
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CLE REQUIREMENTS 

Newly admitted attorneys must complete 32 credit hours of accredited “transitional” education within the 
first two years of admission to the Bar.  Sixteen (16) credit hours must be completed in each of the first two 
years of admission to the Bar as follows: 3 hours of Ethics and Professionalism; 6 hours of Skills; 7 hours of 
Practice Management and/or areas of Professional Practice.   

Experienced Attorneys must complete 24 credit hours of CLE during each biennial reporting cycle: 4 credit 
hours must be in Ethics and Professionalism. The other credit hours may be a combination of the following 
categories: Ethics and Professionalism, Skills, Practice Management or Professional Practice. 

 

NEW CLE REQUIREMENT - CYBERSECURITY: 

Effective January 1, 2023 - New Category of CLE Credit - Cybersecurity, Privacy and Data Protection: A 
new category of CLE credit - Cybersecurity, Privacy and Data Protection - has been added to the CLE Pro-
gram Rules. This category is defined in the CLE Program Rules 22 NYCRR 1500.2(h) and clarified in 
the Cybersecurity, Privacy and Data Protection FAQs and Guidance document. Providers may issue credit in 
Cybersecurity, Privacy and Data Protection to attorneys who complete courses in this new category on or 
after January 1, 2023. 
 
In addition to ethics and professionalism, skills, law practice management, areas of professional practice, and 
diversity, inclusion and elimination of bias courses, there is a new category for cybersecurity, privacy and 
data protection. This category of credit is effective January 1, 2023. 

 
Experienced attorneys due to re-register on or after July 1, 2023 must complete at least one credit hour in 
the Cybersecurity, Privacy and Data Protection CLE category of credit as part of their biennial CLE require-
ment. Newly admitted attorneys need not comply if admitted prior to July 1, 2023 in their newly admitted 
cycle, but must comply in future reporting cycles. Attorneys admitted on or after July 1, 2023, must complete 
the 1 CLE credit hour in Cybersecurity, Privacy and Data Protection as part of their new admitted attorney 
cycle. For more information about the CLE Rules, visit nycourts.gov/Attorneys/CLE.  

See CLE Program Rules 22 NYCRR 1500.22(a). 

Effective July 1, 2023 - Change to Newly Admitted Attorney CLE Requirement to Include One Credit Hour 
in Cybersecurity, Privacy and Data Protection: Newly admitted attorneys whose admission to the NY Bar is 
on or after July 1, 2023 must complete at least 1 CLE credit hour in Cybersecurity, Privacy and Data Protec-
tion as part of their CLE requirement. See CLE Program Rules 22 NYCRR 1500.12(a). 

Attorneys may apply a maximum of three (3) credit hours of cybersecurity, privacy and data protection-
ethics to the four-credit hour ethics and professionalism requirement. 

FINANCIAL HARDSHIP POLICY:  

RCBA members and non-members may apply for tuition assistance to attend Association continuing legal  
education programs based on financial hardship. Any member or non-member of our Association who has a 
genuine financial hardship may apply in writing, no later than five working days prior to the program,  ex-
plaining the basis of his/her hardship, and, if approved, may receive tuition  assistance, depending on the cir-
cumstances. 

https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17a-Rules-1500-2h-Cybersecurity-Definition.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/CLE/Cybersecurity-Privacy-and-Data-Protection-FAQs.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/CLE/Cybersecurity-Privacy-and-Data-Protection-Guidance-Document.pdf
https://ww2.nycourts.gov/attorneys/cle/index.shtml
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17b-Rules-1500-22a-Cybersecurity-Experienced-Attorney-Requirement.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17c-Rules-1500-12a-b-Cybersecurity-Newly-Admitted-Attorney-Requirement.pdf
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     CLE UPDATE  

   CYBERSECURITY REQUIREMENT 
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Effective January 1, 2023 - New Category of CLE Credit - Cybersecurity, Privacy and Data 

Protection: A new category of CLE credit - Cybersecurity, Privacy and Data Protection - has been added 

to the CLE Program Rules. This category is defined in the CLE Program Rules 22 NYCRR 1500.2(h) and 

clarified in the Cybersecurity, Privacy and Data Protection FAQs and Guidance document. Providers may 

issue credit in Cybersecurity, Privacy and Data Protection to attorneys who complete courses in this new 

category on or after January 1, 2023. 

 

Effective July 1, 2023 - Change to Experienced Attorney Biennial CLE Requirement to Include One 

Credit Hour in Cybersecurity, Privacy and Data Protection: Experienced attorneys due to re-register 

on or after July 1, 2023 (birthday is on or after July 1st) must complete at least 1 CLE credit hour in 

Cybersecurity, Privacy and Data Protection as part of their biennial CLE requirement. See CLE Program 

Rules 22 NYCRR 1500.22(a). 

Effective July 1, 2023 - Change to Newly Admitted Attorney CLE Requirement to Include One 

Credit Hour in Cybersecurity, Privacy and Data Protection: Newly admitted attorneys whose 

admission to the NY Bar is on or after July 1, 2023 must complete at least 1 CLE credit hour in 

Cybersecurity, Privacy and Data Protection as part of their CLE requirement. See CLE Program Rules 22 

NYCRR 1500.12(a). 

Attorneys may apply a maximum of three (3) credit hours of cybersecurity, privacy and data protection-

ethics to the four-credit hour ethics and professionalism requirement.  

 

https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17a-Rules-1500-2h-Cybersecurity-Definition.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/CLE/Cybersecurity-Privacy-and-Data-Protection-FAQs.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/CLE/Cybersecurity-Privacy-and-Data-Protection-Guidance-Document.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17b-Rules-1500-22a-Cybersecurity-Experienced-Attorney-Requirement.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17b-Rules-1500-22a-Cybersecurity-Experienced-Attorney-Requirement.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17c-Rules-1500-12a-b-Cybersecurity-Newly-Admitted-Attorney-Requirement.pdf
https://www.nycourts.gov/LegacyPDFS/attorneys/cle/17c-Rules-1500-12a-b-Cybersecurity-Newly-Admitted-Attorney-Requirement.pdf
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COMMITTEE CORNER 

PERSONAL INJURY  & COMPENSATION LAW COMMITTEE 

Your Rockland County Bar Association Personal Injury & Compensation Law (Negligence) 
Committee regularly meets via zoom.  If you are not yet a member and wish to join our com-
mittee, please contact the association.  If you have a topic that you think may be of interest to 
the committee, please let us know. 

Upcoming Meetings: 

March 18, 2024, 5:00 p.m. The committee meeting will be held on Zoom. 

If you are not on the committee and are interested in participating in one of these meetings, 
please contact us. 

Thank you, Jeffrey Adams (Chair) & Valerie Crown (Co-Chair) 

IMMIGRATION LAW COMMITTEE 

Immigration Law is a critical component of our system of laws. We are pleased to announce 
that the Rockland County Bar Association is relaunching the Immigration Committee. The 
committee is being co-chaired by two experienced immigration attorneys, Ivon Anaya, Esq. 
and Crismelly Morales, Esq. Given the recent influx of Immigration in our community, we 
are excited to provide insight and updated information about Immigration Law to the mem-
bers of the Bar Association and our community.  

 

We are looking for new members! If you are interested in joining our committee, please 
email Ivon at Ianaya@centersc.org and Crismelly at Crismelly@cmoraleslaw.com to express 
your interest. Stay tuned for our  future meetings and events! 

NEW LAWYERS AND SOCIAL COMMITTEE 

Nicole DiGiacomo is the new Co-Chair of this Committee and she is looking for new 

members.  The Committee will engage newly admitted attorneys as well as seasoned at-
torneys who are interested in mentoring those newly admitted.   

If you are interested in joining this reinvigorated Committee, please email Nancy at  
Nancy@rocklandbar.org 

PRO BONO COMMITTEE 

This newly established Committee will be meeting soon.  If you are interested in joining this 

Committee, please email Nancy at Nancy@rocklandbar.org 

The Rockland County Bar Association has 26 active committees, plus several ad hoc committees. Members 

may join these committees and volunteer their time and expertise for the good of the Bar Association, their 

colleagues and the public. Here are some of the activities! We look forward to seeing you! 

mailto:Jeff@Injurylaw-ny.com
mailto:vcrown@aol.com
mailto:ianaya@centersc.org
mailto:crismelly@cmoraleslaw.com
mailto:Nancy@rocklandbar.org
mailto:Nancy@rocklandbar.org
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MEMO 

TO ALL RCBA COMMITTEE CHAIRS & VICE – CHAIRS 

 

The Association is seeking articles from your committee for publication in the Bar's monthly  

Newsletter. The membership would greatly benefit from your input and would appreciate it.  

The article does not have to be  complicated or long- a succinct piece of general interest and importance 
would be best.  

 

If you are able to submit an article for the Newsletter it should be sent via email to  

Barbara@rocklandbar.org by the 15th of the month so that the Executive Board may review it.   

 

                                                            Thank you!  

  

 

Visit us online! 

www.Rocklandbar.org 

 

 

mailto:Barbara@rocklandbar.org
http://www.Rocklandbar.org
http://www.rocklandbar.org
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CLASSIFIED ADS Page  

OFFICE SPACE AVAILABLE 
 

The Law Office of L’Tanya M. Watkins locat-

ed in New City has several offices available in 

large suite with conference area and kitchen 

space.  Rent terms are flexible. Great oppor-

tunity for an attorney looking to downsize of-

fice space or share space. Call L’Tanya @845 

-721-3327, or email: 

lwatkinsesq@optonline.net. 

ATORNEY POSITION AVAILABLE 

Feerick Nugent MacCartney (South Nyack) seeking 

NYS admitted attorney with at least 18 months expe-

rience with interest in local government, municipal 

and labor law. Position is full-time, requiring attend-

ance at nightly municipal board meetings (Town/

Village). Benefits available. Starting salary depends 

on applicant’s qualifications - $90,000 to $120,000. 

Will consider higher starting salary commensurate 

with experience. To apply, contact Shannon at  

shannond@fnmlawfirm.com 

  

Matrimonial/Family Law Attorney  
 
Rockland County, NY law firm specializ-

ing in matrimonial and family law is seek-

ing a full time associate. Excellent writing 

skills, trial experience and fluent Spanish 

speaking a plus. Starting salary range is 

$55,000.00 to $85,000.00+. Please call 

845.639.4600 or fax resume to 

845.639.4610 or  

E-mail: michael@demoyalaw.com  

 

IMMIGRATION ATTORNEY WANTED 
 
Rockland County, law firm is seeking a full 
time associate with immigration experience. 
Trial experience, Spanish speaking, admit-
ted to SDNY and willingness to assist with 
bankruptcy and loan modifications a plus. 
Starting salary range is $55,000.00 to 
$85,000.00+.  
Call 845.639.4600 or fax resume to 
845.639.4610 or  
E-mail: michael@demoyalaw.com .  

  

Your Ad Here! 

RCBA Members can 

place a 50 word Clas-

sified Ad for Free! 

See our NEW list-

ing of Affiliate 

and STAR Mem-

bers on our RCBA 

website. Scroll 

down on the 

homepage to 

view. 

mailto:lwatkinsesq@optonline.net
mailto:lwatkinsesq@optonline.net
mailto:shannond@fnmlawfirm.com
mailto:michael@demoyalaw.com
mailto:michael@demoyalaw.com
http://www.rocklandbar.org
http://www.rocklandbar.org
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OUR RCBA 2023-24 

MAJOR SPONSOR 

 

SILVER SPONSOR 

Thank You 

to our Sponsors! 


